



Submit Search


Upload
arduino-esp32-projects.pdf
•
0 likes•142 views


Daniel DonatelliFollow
Stanley A Meyer Legacy Back up Secret Docs Save all Protect Spread print and give to schools NEVER STOP!!!!!!! Join Support here https://www.patreon.com/securesupplies/shopRead less

Read more
Automotive




Report
Share








Report
Share



1 of 14Download NowDownload to read offline





































Recommended
Embedded system application
Embedded system applicationDhruwank Vankawala 


Rdl esp32 development board trainer kit
Rdl esp32 development board trainer kitResearch Design Lab 


Getting Started with the NodeMCU- NodeMCU Programming (By Akshet Patel)
Getting Started with the NodeMCU- NodeMCU Programming (By Akshet Patel)AkshetPatel 


ESP32 WiFi & Bluetooth Module - Getting Started Guide
ESP32 WiFi & Bluetooth Module - Getting Started Guidehandson28 


Arduino and Circuits.docx
Arduino and Circuits.docxAjay578679 


aurduino-200107075953.pdf
aurduino-200107075953.pdfHebaEng 


Arduino: On-board components description, IDE and Programming 
Arduino: On-board components description, IDE and Programming Pawan Dubey, PhD 


Embedded L1_notes_unit2_architecture.pptx
Embedded L1_notes_unit2_architecture.pptxaartis110 










Similar to arduino-esp32-projects.pdf
Physical prototyping lab1-input_output (2)
Physical prototyping lab1-input_output (2)Tony Olsson. 


What is arduino
What is arduinovivek kumar 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdmukhammadimam 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdsiti_haryani 










Similar to arduino-esp32-projects.pdf
Monitoring temperature ruangan dengan display lcd dan recording
Monitoring temperature ruangan dengan display lcd dan recordingMR Selamet 


IOT WORKSHEET 1.4.pdf
IOT WORKSHEET 1.4.pdfMayuRana1 


wireless charging of an electrical vechicle 3
wireless charging of an electrical vechicle 3hari prasad 


Lab2ppt
Lab2pptZhentao Xu 










Similar to arduino-esp32-projects.pdf
AVR HOW-TO GUIDE Interfacing SPI-Ethernet With AVR Slicker Contents At A Glance
AVR HOW-TO GUIDE Interfacing SPI-Ethernet With AVR Slicker Contents At A GlanceScott Faria 


IoT Platform
IoT PlatformSaurabh Singh 


IoT Platform
IoT PlatformSaurabh Singh 


Monitoring temperature rumah dengan display lcd dan recording
Monitoring temperature rumah dengan display lcd dan recordingMR Selamet 










Similar to arduino-esp32-projects.pdf
Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdsiti_haryani 


SKAD Electronics Training Manual.pdf
SKAD Electronics Training Manual.pdfKadiriIbrahim2 


Arduino uno
Arduino unoSAKIBNESARRATUL20135 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdmukhammadimam 










More Related Content
Similar to arduino-esp32-projects.pdf
Physical prototyping lab1-input_output (2)
Physical prototyping lab1-input_output (2)Tony Olsson. 



What is arduino
What is arduinovivek kumar 



Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdmukhammadimam 



Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdsiti_haryani 



Monitoring temperature ruangan dengan display lcd dan recording
Monitoring temperature ruangan dengan display lcd dan recordingMR Selamet 



IOT WORKSHEET 1.4.pdf
IOT WORKSHEET 1.4.pdfMayuRana1 



wireless charging of an electrical vechicle 3
wireless charging of an electrical vechicle 3hari prasad 



Lab2ppt
Lab2pptZhentao Xu 



AVR HOW-TO GUIDE Interfacing SPI-Ethernet With AVR Slicker Contents At A Glance
AVR HOW-TO GUIDE Interfacing SPI-Ethernet With AVR Slicker Contents At A GlanceScott Faria 



IoT Platform
IoT PlatformSaurabh Singh 



IoT Platform
IoT PlatformSaurabh Singh 



Monitoring temperature rumah dengan display lcd dan recording
Monitoring temperature rumah dengan display lcd dan recordingMR Selamet 



Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdsiti_haryani 



SKAD Electronics Training Manual.pdf
SKAD Electronics Training Manual.pdfKadiriIbrahim2 



Arduino uno
Arduino unoSAKIBNESARRATUL20135 



Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcdmukhammadimam 



Monitoring Temperature Room With Display LCD and Data Recording
Monitoring Temperature Room With Display LCD and Data RecordingMR Selamet 



Lecture 7
Lecture 7vishal choudhary 



Monitoring temperature rumah dengan display lcd dan recording
Monitoring temperature rumah dengan display lcd dan recordingYuda Wardiana 



Contactless digital tachometer using microcontroller 
Contactless digital tachometer using microcontroller IJECEIAES 





Similar to arduino-esp32-projects.pdf (20)
Physical prototyping lab1-input_output (2)
Physical prototyping lab1-input_output (2) 


What is arduino
What is arduino 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcd 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcd 


Monitoring temperature ruangan dengan display lcd dan recording
Monitoring temperature ruangan dengan display lcd dan recording 


IOT WORKSHEET 1.4.pdf
IOT WORKSHEET 1.4.pdf 


wireless charging of an electrical vechicle 3
wireless charging of an electrical vechicle 3 


Lab2ppt
Lab2ppt 


AVR HOW-TO GUIDE Interfacing SPI-Ethernet With AVR Slicker Contents At A Glance
AVR HOW-TO GUIDE Interfacing SPI-Ethernet With AVR Slicker Contents At A Glance 


IoT Platform
IoT Platform 


IoT Platform
IoT Platform 


Monitoring temperature rumah dengan display lcd dan recording
Monitoring temperature rumah dengan display lcd dan recording 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcd 


SKAD Electronics Training Manual.pdf
SKAD Electronics Training Manual.pdf 


Arduino uno
Arduino uno 


Monitoring temperature ruangan dengan display lcd
Monitoring temperature ruangan dengan display lcd 


Monitoring Temperature Room With Display LCD and Data Recording
Monitoring Temperature Room With Display LCD and Data Recording 


Lecture 7
Lecture 7 


Monitoring temperature rumah dengan display lcd dan recording
Monitoring temperature rumah dengan display lcd dan recording 


Contactless digital tachometer using microcontroller 
Contactless digital tachometer using microcontroller  






More from Daniel Donatelli
ca1231872a1-hydrogen-injection-system.pdf
ca1231872a1-hydrogen-injection-system.pdfDaniel Donatelli 



bubbles.pdf
bubbles.pdfDaniel Donatelli 



esp32-microcontroller-programming-principles-for-operation-of-steam-resonator...
esp32-microcontroller-programming-principles-for-operation-of-steam-resonator...Daniel Donatelli 



electrical-polarization-process (1).pdf
electrical-polarization-process (1).pdfDaniel Donatelli 



duty-cycle-vs-independent-widthspacing-control.pdf
duty-cycle-vs-independent-widthspacing-control.pdfDaniel Donatelli 



chris-bake.pdf
chris-bake.pdfDaniel Donatelli 



energy-of-the-future-rz-vol-2-no-1-1990.pdf
energy-of-the-future-rz-vol-2-no-1-1990.pdfDaniel Donatelli 



dynamic-ways-to-produce-electricity.pdf
dynamic-ways-to-produce-electricity.pdfDaniel Donatelli 



canadian-patents.pdf
canadian-patents.pdfDaniel Donatelli 



christophes-adjustable-flat-plate-cells.pdf
christophes-adjustable-flat-plate-cells.pdfDaniel Donatelli 



electrical-polarization-process.pdf
electrical-polarization-process.pdfDaniel Donatelli 



driver.pdf
driver.pdfDaniel Donatelli 



gated-pulse-frequency (1).pdf
gated-pulse-frequency (1).pdfDaniel Donatelli 



christophe-campain.pdf
christophe-campain.pdfDaniel Donatelli 



core-permeability.pdf
core-permeability.pdfDaniel Donatelli 



chapters.pdf
chapters.pdfDaniel Donatelli 



canadian-patents (1).pdf
canadian-patents (1).pdfDaniel Donatelli 



cell-construction.pdf
cell-construction.pdfDaniel Donatelli 



different-polarity-firing-sequences-for-electrodes-in-the-steam-generator-as-...
different-polarity-firing-sequences-for-electrodes-in-the-steam-generator-as-...Daniel Donatelli 



us-edition.pdf
us-edition.pdfDaniel Donatelli 





More from Daniel Donatelli (20)
ca1231872a1-hydrogen-injection-system.pdf
ca1231872a1-hydrogen-injection-system.pdf 


bubbles.pdf
bubbles.pdf 


esp32-microcontroller-programming-principles-for-operation-of-steam-resonator...
esp32-microcontroller-programming-principles-for-operation-of-steam-resonator... 


electrical-polarization-process (1).pdf
electrical-polarization-process (1).pdf 


duty-cycle-vs-independent-widthspacing-control.pdf
duty-cycle-vs-independent-widthspacing-control.pdf 


chris-bake.pdf
chris-bake.pdf 


energy-of-the-future-rz-vol-2-no-1-1990.pdf
energy-of-the-future-rz-vol-2-no-1-1990.pdf 


dynamic-ways-to-produce-electricity.pdf
dynamic-ways-to-produce-electricity.pdf 


canadian-patents.pdf
canadian-patents.pdf 


christophes-adjustable-flat-plate-cells.pdf
christophes-adjustable-flat-plate-cells.pdf 


electrical-polarization-process.pdf
electrical-polarization-process.pdf 


driver.pdf
driver.pdf 


gated-pulse-frequency (1).pdf
gated-pulse-frequency (1).pdf 


christophe-campain.pdf
christophe-campain.pdf 


core-permeability.pdf
core-permeability.pdf 


chapters.pdf
chapters.pdf 


canadian-patents (1).pdf
canadian-patents (1).pdf 


cell-construction.pdf
cell-construction.pdf 


different-polarity-firing-sequences-for-electrodes-in-the-steam-generator-as-...
different-polarity-firing-sequences-for-electrodes-in-the-steam-generator-as-... 


us-edition.pdf
us-edition.pdf 









Recently uploaded
Quality Chinese Truck Spare Parts (B)-PASOU
Quality Chinese Truck Spare Parts (B)-PASOUBenWong328672 



Diagnostic software DTS Monaco How To 2019.pdf
Diagnostic software DTS Monaco How To 2019.pdfxkey861 



MSES Manual - Mahindra & Mahindra customer specific requirements
MSES Manual - Mahindra & Mahindra customer specific requirementsIlayarajaMK1 



idea development.pptxcccccccccccccccccccccccccccccccc
idea development.pptxcccccccccccccccccccccccccccccccclolsDocherty 



Project Summary 2.pdf project summary pr
Project Summary 2.pdf project summary prIvannaCervantes2 



Intddddddddd-to-Criminal-Law-Slides.pptx
Intddddddddd-to-Criminal-Law-Slides.pptxAshadulHoqueJahin1 





Recently uploaded (6)
Quality Chinese Truck Spare Parts (B)-PASOU
Quality Chinese Truck Spare Parts (B)-PASOU 


Diagnostic software DTS Monaco How To 2019.pdf
Diagnostic software DTS Monaco How To 2019.pdf 


MSES Manual - Mahindra & Mahindra customer specific requirements
MSES Manual - Mahindra & Mahindra customer specific requirements 


idea development.pptxcccccccccccccccccccccccccccccccc
idea development.pptxcccccccccccccccccccccccccccccccc 


Project Summary 2.pdf project summary pr
Project Summary 2.pdf project summary pr 


Intddddddddd-to-Criminal-Law-Slides.pptx
Intddddddddd-to-Criminal-Law-Slides.pptx 








arduino-esp32-projects.pdf

	1. ESP32 - Complex  Waveform Generator V2
ESP32 - CWG Driver & Amplification
ESP32 - Complex Waveform Generator V3
Arduino / ESP32
Projects
 


	2. https://www.youtube.com/embed/AxDYTR773SM
1 - ESP32  (WROOM-32 or WROVER-32) with 16 exposed pins
1 - ESP32 Breakout Board or equivalent pin header block
7 - Rotary Encoders (i.e. KY-040 Rotary Encoder Module CYT1062)
TODO: add >= 2 more for Elongation adjustments.
1 - +5VREG 1A Power Supply for ESP32 (i.e. ATX PowerSupply)
Install ESP Libraries in Arduino-IDE v2.0
Check your Router for more information
ESP32 - Complex Waveform
Generator V2
Setting Up The App
ESP32 Complex Waveform Generator - Arrangement for WROOM-32 or WROVER-E (DevKit-C)
PARTS Required
Installation Prerequisites
ArduinoJson
ESP32Encoder
Step 1. Open Esp32Full.ino and set Wifi Credentials
// #### Change Me - Local Wifi Info ####
const char *SSID = "NETGEAR";
const char *PWD = "12345678";
Step 2. Configure free local LAN IP address
 


	3. Edit `./assets/espwavegen.js` and  set the IP address used in Step 2 above.
Save and close the file
Paste the code into your Arduino-IDE and upload it to your ESP32
Open Web Browser
Open `index.html` in the `WebApp` directory below this file
File -> Open -> Browse to WebApp/index.html -> Open
Interface is now displayed!
Please post pics and videos of your waves, and let others know how achievable this is!
// #### CHANGE ME ####
// Set your Static IP address to a free IP in your local network
IPAddress local_IP(192, 168, 1, 8);
// Set your Gateway IP address
IPAddress gateway(192, 168, 1, 1);
IPAddress subnet(255, 255, 255, 0);
IPAddress primaryDNS(8, 8, 8, 8); //optional
IPAddress secondaryDNS(8, 8, 4, 4); //optional
Step 3. Configure ESP_HOST in Javascript File
TODO: Make configurable in the web interface
Step 3. Upload The code in `Esp32Full.ino`
Installing the ESP32 Board in Arduino IDE
Step 4. Access the WebApp in your Web Browser
Step 5: Enjoy!!
 


	4. Output will be  on Pins D2 and D4 by default
Need Amplification?
See: ESP32 - Complex Waveform Generator - Driver & Amplification
Additional Troubleshooting / Customization
Optional: Configure alternate Output Pins
// #### Output Pins ####
int pinChannel1 = 2;
int pinChannel2 = 4;
Optional: Adjust Encoder Pins if needed
 


	5. View the Console  Log for errors in your browser while clicking the app's sliders buttons etc..
Look in the Network tab for red errors. 404 or other. Sometimes the ESP may drop or reject the
connection on the first attempt. Just refresh the browser once or twice and it should resolve.
int pulseCount_EncoderPIN1 = 14;
int pulseCount_EncoderPIN2 = 13;
int pulseWidth_EncoderPIN1 = 35;
int pulseWidth_EncoderPIN2 = 34;
int pulseSpace_EncoderPIN1 = 19;
int pulseSpace_EncoderPIN2 = 18;
int gate_freq_EncoderPIN1 = 22;
int gate_freq_EncoderPIN2 = 23;
int pulseWidthModifier_EncoderPIN1 = 27;
int pulseWidthModifier_EncoderPIN2 = 26;
int pulseSpaceModifier_EncoderPIN1 = 5;
int pulseSpaceModifier_EncoderPIN2 = 32;
int gateModifier_EncoderPIN1 = 25;
int gateModifier_EncoderPIN2 = 33;
ESP C+ Code
Git Repo: https://bitbucket.org/cbake6807/esp32-complex-waveform-generator/src/master/
Troubleshooting:
 


	6. Screenshot from 2022-08-06  13-24-55.png
Image not found or type unknown
Confirm the ESP is a connected host in your network and was given the IP you specified
Code notes if internet connectivity isn't an option. Also, encoder wiring connections for this
particular setup (Notepad++ document file type). Chris Bake ESP32 notes.txt
Notepad++ download: Notepad++
https://www.browserstack.com/guide/inspect-element-in-
chrome#:~:text=One%20of%20the%20easiest%20ways,%2C%20Sources%2C%20and%20ot
her%20tools.
https://www.wikihow.com/See-Who-Is-Connected-to-Your-Wireless-Network
 


	7. ESP32 - CWG  Driver &
Amplification
A dual channel, dual isolated power supply, pulse
amplification for driving all VIC arrangements
 



	9. Arrangement favoring Particle  Oscillation as an Energy Generator
Variation 2 - Ground Bonded / "Forced" Uni-polar Operation
 



	11. Screenshot of web  interface
To use this application, you need to have the Arduino IDE installed on your computer. You can
download the Arduino IDE from the official website: https://www.arduino.cc/en/software
1. ESP32 Development Board: You'll need an ESP32 development board, such as the
popular ESP32-DevKitC or ESP32-WROOM-32D. These boards typically come with Wi-Fi
and Bluetooth capabilities and a variety of GPIO pins for interfacing with peripherals.
2. Rotary Encoders: To adjust the waveform parameters, you will need a total of 7 rotary
encoders. You can use KY-040 rotary encoder modules or any other type of incremental
rotary encoder with built-in push buttons. Ensure that the rotary encoders you choose
have a CLK, DT, and SW (push button) pinout.
3. Breadboard and Jumper Wires: A breadboard and jumper wires are required to make
the necessary connections between the ESP32 development board and the rotary
encoders.
4. Power Supply: You will need a power supply to power the ESP32 development board.
This can be a USB power supply, a battery, or any other suitable power source that meets
ESP32 - Complex Waveform
Generator V3
Installing and Using the ESP32 Complex Waveform
Generator V3 Application
Prerequisites
 


	12. the board's voltage  and current requirements, such an ATX Supply from a computer.
5VDC 1A minimum is recommended to prevent brownout conditions while interacting with
a driver circuit.
5. Oscilloscope (optional): To visualize the generated waveform, you can use an
oscilloscope. Connect the output pins (channel1OutputPin and channel2OutputPin) from
the ESP32 development board to the oscilloscope's input channels.
1. ArduinoJson: To install the ArduinoJson library, follow these steps: a. Open the Arduino
IDE. b. Click on Tools in the menu bar, then Manage Libraries . c. In the Library Manager
window, search for "ArduinoJson" in the search bar. d. Find "ArduinoJson by Benoit
Blanchon" in the search results and click on the Install button.
2. ESP32Encoder: To install the ESP32Encoder library, follow these steps: a. Open the
Arduino IDE. b. Click on Tools in the menu bar, then Manage Libraries . c. In the Library
Manager window, search for "ESP32Encoder" in the search bar. d. Find "ESP32Encoder by
Gil Mora" in the search results and click on the Install button.
1. Download the source code for the ESP32 Complex Waveform Generator V3 application or
copy it to a new file in the Arduino IDE.
2. Connect the ESP32 development board to your computer using a USB cable.
3. In the Arduino IDE, select the appropriate board and port under Tools > Board and Tools
> Port .
4. Click on the Upload button (right-facing arrow icon) in the Arduino IDE to compile and
upload the application to the ESP32 development board.
1. Wire the rotary encoders and other components according to the pin assignments defined
in the source code.
ESP32 Pin Encoder Connection Encoder Function
14 Pulse Encoder CLK Pulse count
13 Pulse Encoder DT Pulse count
35 Width Encoder CLK Pulse width
34 Width Encoder DT Pulse width
19 Spacing Encoder CLK Pulse spacing
Installing required libraries
Uploading the Application
Hardware Setup
 


	13. ESP32 Pin Encoder  Connection Encoder Function
18 Spacing Encoder DT Pulse spacing
23 Off-time Encoder CLK Off-time
22 Off-time Encoder DT Off-time
27 Width Mod Encoder CLK Width modifier
26 Width Mod Encoder DT Width modifier
15 Spacing Mod Encoder CLK Spacing modifier
32 Spacing Mod Encoder DT Spacing modifier
33 Off-time Mod Encoder CLK Off-time modifier
4 Off-time Mod Encoder DT Off-time modifier
2 Output Channel 1 Output waveform
5 Output Channel 2 Output waveform
2. Make sure the connections are secure and verify the CLK/DT pins for each encoder are
wired correctly, and that each encoder turns in the correct direction relative to the
respective parameter change.
1. Power on the ESP32 development board.
2. Use the rotary encoders to adjust the following parameters:
Pulse count
Pulse width
Pulse spacing
Off-time
Width modifier
Spacing modifier
Off-time modifier
3. The application will generate a complex waveform based on the adjusted parameters.
4. Connect the output pins (channel1OutputPin and channel2OutputPin) to an oscilloscope to
visualize the generated waveform.
5. Open the WebApp/index.html page in a browser.
6. Fine-tune the parameters using the rotary encoders to achieve the desired waveform
shape and characteristics.
Using the Application
Next Steps For Utilization
 


	14. Build ESP32 CWG  - VIC Driver circuit(s) - https://stanslegacy.com/books/chris-
bake/page/esp32-cwg-driver-amplification
Cell Construction - https://stanslegacy.com/books/ethan-crowder/page/resonant-cavity-
related
1. If the waveform does not match the expected output, verify the wiring connections and
ensure the rotary encoders are functioning correctly.
2. If the application does not upload to the ESP32 development board, double-check the
board and port selection in the Arduino IDE.
3. If the rotary encoders behave unexpectedly (e.g., adjusting one parameter affects
another), check the CLK/DT pin assignments and wiring.
4. Click the PInout button to fetch the currently defined GPIO pins from the ESP32 directly
and confirm they are wired correctly.
For further assistance or to report any issues, contact the application's support team or refer to the
community forums.
Troubleshooting
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